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Riassunto 

 

Lo scopo di questo progetto consiste nell’andare ad identificare nuovi 

biomarker per la valutazione dello stato di salute degli squali pescati in 

Adriatico e la loro suscettibilità ai cambiamenti ambientali.  

Per raggiungere questo obiettivo si è andati ad utilizzare i melanomacrofagi 

come biomarker di stress, già ampiamente utilizzati in teleostei, anfibi e 

rettili, in questi organismi. 

In questo studio sono stati valutati i melanomacrofagi epatici in quattro specie 

di squalo pescate in Adriatico, sia da un punto di vista morfologico che 

quantitativo, valutandone le differenze fra le specie, fra i sessi e, dove 

possibile, fra questi ultimi ed il periodo riproduttivo. Infine, si è valutato se 

fosse presente una correlazione significativa tra i melanomacrofagi e l’età nei 

maschi di palombo. 
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Chapter 1 

INTRODUCTION 
 

  

1.1 Systematics 

 

Chondrichthyes are a class of Vertebrates whose earliest fossils date back to 

the Devonian period (410-460 MA) of the Paleozoic Era.  This fact shows the 

evolutionary success of this clade since it was able to overcome all five mass 

extinctions keeping its essential characteristics almost unchanged. The name 

of the class is formed from the Greek prefix khondros, meaning “cartilage” 

and suffiss ikhthus for “fish”, due to the fact that their entire skeleton is made 

of cartilage. 

This class includes 1223 species divided into 2 subclasses: Holocephali, 

which is made up of 52 species of organisms known as chimeras which all fall 

into the sole order of the Chimaeriformes, and Elasmobranchii (from the 

Greek, elasmòs = thin plate + from Latin, branchia), which are characterized 

by the presence of thin flaps of connective tissue that support the gills and 

separate the multiple gill openings vertically. This latter subclass is further 
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separated into two subdivisions: Selachii, the sharks (532 species), and 

Batoidea, the rays (634 species) (IUCN, 2020). 

Sharks are divided into 8 orders: Hexanchiformes, Squaliformes, 

Squatiniformes, Pristiophoriformes, Heterodontiformes, Lamniformes, 

Orectolobiformes and Carchariniformes. The first four are grouped into the 

superorder Squalomorphii. The species belonging to this clade have large 

spiracles while fin spines and anal fin can be present or absent and they have 

from 5 to 7 gill openings (Ari et al., 2008). 

The last four orders are grouped into the superorder Galeomorphii. These 

species have five gill slits and an anal fin, lack fin spines and are presently the 

dominant group of sharks, found in all habitats in which sharks occur, except 

in the Arctic seas, which are inhabited by the squalomorph sleeper shark 

Somniosus microcephalus (http://species-identification.org/). 

Most cartilagineous fishes have dermal denticles, better known as placoid 

scales, covering their skin to reduce drag. These anatomical structures are 

formed continuously during the life of the animal, they are shed and replaced 

as an individual grows. Shark’ teeth are derived from dermal denticles which 

have become concentrated along the margin of the jaw and are organized in 

rows: the outermost row is continuously replaced by the next one. 

  

http://species-identification.org/
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1.2 General aspects  

 

Sharks are found in all marine environments from the equator to the poles 

with a latitudinal gradient of biodiversity that decreases from the former to the 

latter. They occupy a wide range of habitats, from fresh and brackish waters 

to the open ocean and, as long as it’s known, at all depths up to 3000m. (Ebert 

& Dando, 2021).  

 

Sharks are carnivores with different feeding types ranging from filter-feeding 

to active predation. Most larger species are apex predators but there is a high 

diversity of mesopredators as shown by values of trophic level ranging from 

3.1 (Stegosoma fasciatum) to 4.5 (Carcharodon carcharias), without 

considering the basking shark Cetorhinus maximus, the whale shark 

Rhincodon typus and the megamouth shark Megachasma pelagios, the three 

filter-feeding species of sharks (Cortés, 1999; Ferretti et al., 2010; Hobson & 

Welch, 1992). Features that allow these animals to be high in the food web 

are their hyostilic suspension of the jaw and their efficient dentition, which 

enable them to cut large prey into chunks, therefore consuming even larger 

animals. This is why many sharks are generalists in terms of prey items and 

why they play an important role in marine food webs, exerting a top-down 

control in ecosystem structure and functioning (Dulvy et al., 2014). 
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All Chondrichthyes have internal fertilization that occurs through a pair of 

claspers, intromittent organs derived from a modification of male pelvic fins. 

This mode of fertilization ensures that neither eggs nor sperms are broadcast 

haphazardly into the water column since there is a very high investment of 

energy of the mother in producing offspring to provide a direct development 

of the embryo.  

Despite the unique mode of fertilization, Chondrichthyes display a wide range 

of reproductive strategies. About 43% of the species are oviparous 

(Compagno, 1990): in this case the embryos are encased in a hornlike egg 

case which is deposited in a safe place in the external environment. The rest 

of the species are viviparous and retain the embryos within the uterus 

throughout their entire period of development. 

Viviparity can be divided into aplacental and placental viviparity depending 

on the trophic connection of the embryo with the mother. 

Aplacental viviparity is a term that comprehends more than one mode of 

development:  

• Yolk sac viviparity, better known as ovoviviparity, is the condition 

where the embryos gain nourishment solely from the yolk sac 

(lecithotrophic development) but they remain inside the mother’s 
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womb until they’re able to be released into the external environment.  

Since there is no supplementary nourishment from the mother, 

youngsters are relatively small at birth. 

• In aplacental oophagy uterine walls become large to accommodate a 

large number of eggs, mostly unfertilized, that will be the source of 

nourishment of one or few developing embryos which rely exclusively 

on their yolk sac until they develop a premature dentition that allows 

them to rupture the eggs and feed on their content. In the case of the 

sand tiger shark Carcharias taurus up to a dozen of embryos may be 

present in each of the two uteri and the fastest developing ones start to 

feed on their siblings, resulting in the parturition of two youngsters, one 

per uterus. This is known as intrauterine cannibalism and the result is a 

great size at birth, around 100cm, and an increased chance of survival. 

• Dogfish sharks of the order Squaliformes and some sharks in the orders 

Orectolobiformes and Carchariniformes gain nourishment not only 

from their yolk sac but also from mucus secreted from cells on the 

surface of the uterus. This mode of nourishment is termed 

“histotrophy”. In the stingrays of the order Myliobatiformes, many 

large projections with villi on them extend from the wall of the uterus 

toward the embryo, increasing the surface for the secretion of mucus 
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mostly composed of lipids, which have an high energy content. These 

projections are called trophonemata, and this kind of embryo’s 

nourishment is named “lipid histotrophy”. 

 

In placental sharks, the yolk sac becomes highly vascularized and 

interdigitates with the uterine wall forming a placenta, through which 

nutrients are carried within the bloodstream from the mother to the embryo. 

The gestation period is unknown for most species but it has a wide range 

depending on the species and can reach up to 22 months in the spiny dogfish 

Squalus acanthias. 

Depending on the species and on the body size of the mother, females may 

bear from 1-2 (as in the case of Carcharias taurus) to 300 youngs (whale 

shark Rhincodon typus).  

Chondrichthyes exhibit a direct development, meaning that the youngsters are 

a miniature copy of the adult and they can survive into the external 

environment on their own, in fact parental care has never been documented. 

High natural survivorship is one of the general aspects that characterize this 

group together with slow growth, late age at maturity, long gestation periods, 

low fecundity and high longevity, all features that are typical of a K-selected 

life history strategy. 
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There is a general lack of knowledge for many aspects related to these 

animals and the information are mostly limited to charismatic species, 

commercially-important fisheries, and coral reef ecosystems (Dulvy et al., 

2014). In addition there are logistic problems to the study of these animals 

such as data collection for highly migratory species or for species living in the 

deep-sea. 

 

 

1.3 Threats 

 

The rapid growth of the human population implies a higher demand for 

resources. To cope with the high demand for seafood, the fishing industry is 

increasing the pressure on the stocks. (Cataudella & Spagnolo, 2011; Dulvy et 

al., 2014; Ferretti et al., 2008) This industry faced a strong development after 

the Second World War thanks to the development of new technologies and 

the advent of commercial refrigeration which allowed to reach further 

distances for a longer period and store more products (Cavanagh et al., 2005). 

The result of this development was a stronger pressure on stocks, a decline of 

traditional food fish stock, and a consequent switch to lower-grade market 

fish. 
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Chondrichthyes are highly vulnerable to overfishing pressure because of their 

life history characteristics such as slow growth, low fecundity, and late 

maturity and it has been shown that populations of these animals can 

withstand only modest periods of fishing pressure which are followed by 

severe declines in catch rates, a cycle known as “boom-and-bust” (Cavanagh 

et al., 2005; Field et al., 2009). This is because, for longer-lived and less 

productive species, the initial rate of exploitation may exceed the rate at 

which the stock can replenish itself through reproduction, and right from the 

beginning the catches are unsustainable. 

Many shark fisheries have collapsed in the past. One example is the one of the 

tope shark Galeorhinus galeus in the North-East Pacific: the fishery expanded 

greatly in 1936 for the high demand for shark’s liver’s oil, used as a source of 

vitamin A and for lubricant for military machinery before and during the 

Second World War, and then collapsed in 1944. The time span between boom 

and bust was eight years for this fishery (Klimley, 2013; Field et al., 2009). 

 

Sharks are mainly fished as bycatch but commodities deriving from shark 

fishery are varied: they provide meat and fins for human consumption; 

leather; live specimen for aquaria; teeth, jaws, and branchial arches are sold as 

souvenirs; liver’s oil is used to produce lubricants, cosmetics, vitamin A, and 
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it’s used also as an adjuvant in vaccines; shark’s cartilage is used in 

pharmaceutical for the treatment of arthritis and other ailments. 

Particularly alarming is the market of shark fins which are a highly valued 

commodity in Asia, especially in China where there are records of this 

product as a delicacy since the Song dynasty (940-1279), and since then shark 

fin’s soup has been considered as a high-status meal (Cavanagh et al., 2005). 

According to FAO (Dent & Clarke, 2015) the trade of fins generates a profit 

of around 100 million dollars higher than the one of shark meat even though 

the quantity of product is around a seventh of the former in respect of the 

latter.  

Since sharks are fished mainly as bycatch in fisheries targeting other species 

of higher value and since fins are significantly more valuable than meat, 

fishermen cut off the fins of sharks they catch and discard the rest of the body 

at sea, often still alive. This practice is known as “finning” and fins are stored 

together with target species since they don’t take up much storage space as 

the whole animal. This practice is illegal and unethical and there’s a 

tremendous lack of data because there is no information of the exact species 

traded, landings may often be unreported, and the market is globally 

widespread if considering both exporters and importers therefore there is a 

difficulty in tracking the source.  
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According to the IUCN Red List, the main threat is overfishing but others are 

habitat loss and pollution. Life histories of sharks are quite varied depending 

on the species and many still need to be understood but generally, sharks 

move from mating areas, to nursery areas, and to feeding areas, therefore, 

requiring more habitats: loss of coastal habitats, or other kinds, can therefore 

compromise the recruitment for some species.  

Pollution is a threat to all kinds of environments and can affect 

Chondrichthyes both directly or indirectly, through changes in water quality 

and habitat degradation. Generally, these animals are highly mobile so they 

can move from a place of less quality to a better one but certain life stages 

confined to a limited environment are more at risk.  

Chondrichthyes can also bio-accumulate heavy metals and other pollutants 

such as organic chemical compounds that can have implications on the 

reproductive, immune, endocrine, and nervous systems.  

Another source of pollution is the disruption of natural electro-magnetic fields 

around undersea cables since these animals rely on their electrosensory 

system for foraging and for migrating (Field et al., 2009). 
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1.4 Sharks in the Mediterranean 

 

The Mediterranean hosts 76 species of Chondrichthyes (2 Chimaeriformes, 31 

Batoidea, and 43 Selachi), around 6% of the 1223 species known globally, 

enough to consider the basin a hotspot for these animals. However, a total of 

49 species (64,4% of the total) are considered among the threatened 

categories of the IUCN Red List (Vulnerable,VU; Endangered, EN; Critically 

Endangered, CR) which makes them the most endangered group of fish of the 

basin. The Mediterranean sea is at the same time the area in the world with 

the highest proportion of threatened species because of unregulated fishing 

(Bradai et al., 2018). The distribution of these species is not homogenous 

throughout the basin (Serena, F. 2005) and some habitats are considered 

critical for this group, even though there is a big lack of knowledge about it 

(Bradai et al., 2018). The biodiversity of elasmobranchs is highest in the 

western coastal Mediterranean while decreases going toward the eastern 

Mediterranean. 

Species found in the Mediterranean can be split into 3 ecological groupings 

based on where they live in relation to continental landmasses and seabed: 

continental shelf species live from the coastal shore to depths of 200m; 

deepsea species live close to the seafloor at depths below 200m; oceanic 

species have no relation with the seafloor and live primarily away from 
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continental landmasses or close to offshore islands where the continental 

slope is not far from the coastline. 

Some species are pelagic, others spend their whole life on the seabed and are 

considered benthic, others swim into the water column but feed mainly on 

benthic species and these are considered benthopelagic (Ebert & Dando, 

2021; (Cataudella & Spagnolo, 2011). The majority (around 80%) of 

Mediterranean elasmobranch are coastal and benthic.  

The Mediterranean has been inhabited for millennia and it still has a high 

density of inhabitants along its coasts and a high influx of tourists each year 

and which results in a high anthropic pressure especially along the coastal 

areas of the basin, where fishing efforts also are more concentrated. 

FAO statistics (1980-2015) show that landings of elasmobranchs decreased 

over the years while CPUE (Catch Per Unit Effort) generally increased. Many 

works have pointed out this statement (Jukic-Peladic et al., 2001; (Ferretti et 

al., 2008); Cataudella & Spagnolo, 2011; Robbins, 2014) and shown that, at 

least since the first decades of the last century, demersal communities in the 

Mediterranean were more diversified thanks to the presence of large predators 

while now the communities are characterized by species with faster growth 

and higher fecundity. 
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Elasmobranchs are mainly caught as bycatch but there are also examples of 

target fishery in the basin: in Tunisia and Libya after the decrease in 

swordfish catch, longlines that were previously used for that fishery are now 

used to catch sandbar shark Carcharhinus plumbeus; in North Adriatic and in 

a restricted area of the Turkish mediterranean coast gillnets are used to target 

Mustelus spp., which is the most targeted species of elasmobranch in the 

whole Mediterranean due to its distribution in the basin. 

Cartilagineous fishes are caught accidentally in most fishing gears in the 

Mediterranean both in small-scale and industrial fisheries: 

• Surface longlines that target tuna and swordfish affect pelagic sharks 

such as blue shark Prionace glauca and shortfin mako Isurus 

oxyrhynchus; 

• Bottom longlines that target groupers affect more benthic sharks such 

as the ones of the genus Mustelus; 

• Trawlers affect all species of elasmobranchs, particularly demersal 

species such as Mustelus spp., Scyliorhinus canicula, and Squalus 

acanthias. 
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Elasmobranch situation has not passed undetected and since the last decade of 

the twentieth-century efforts are being made to mitigate pressure on these 

animals: 

• 1996: European Elasmobranch Association (EEA) is established for 

coordinating the activities of national European organizations dedicated 

to the study, management, or conservation of chondrichthyans (sharks, 

skates, rays, and chimeras). 

• 1999: FAO adopted the International Plan of Action (IPOA-Sharks) to 

ensure the conservation and management of sharks, skates, rays, and 

chimeras fished in territorial waters of the countries of the UN, and 

their long-term sustainable use. 

• 2003: EU adopts the first finning regulation (No 605/2013) allowing 

sharks to be processed on board by removing their fins from their 

bodies and providing a “fin-to-carcass” ratio, to ensure that there is a 

correlation between the weight of a shark’s fins and its body. Fins and 

bodies can be landed in different ports. 

• 2004: ICCAT (Internation Commission for the Conservation of 

Atlantic Tunas) adopts shark finning regulation of the previous year. 

• 2012: GFCM (General Fishery Commission for the Mediterranean) 

prohibits retention of 24 species of elasmobranchs listed in Annex II 
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(Endangered and threatened species) of the Barcelona Convention 

SPA/BD Protocol. 

• 2013: EU adopts Fins Naturally Attached (FNA) for simpler and more 

effective monitoring and enforcement. 

• 2018: GFCM adopts FNA 

• 2019: ICCAT adopts the first international catch limit in the Atlantic 

for blue shark P.glauca. 

• 2020: EU adopts blue shark quota; UNEP/MAP Cartilaginous Fishes 

Action Plan update. 
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1.5 Species used in the study 

 

SQUALUS ACANTHIAS 

Order: Squaliformes 

Family: Squalidae 

Ecology 

This species has a worldwide distribution except for the tropical and polar 

regions and the north Pacific, where it’s replaced by S.suckleyi (Bargione et 

al., 2019). It occupies a variery of habitats from estuaries to the upper 

continental slope but it is more common on the continental shelf in waters 

between 7 to 15°C. It is a highly migratory demersal shark but can be found 

also in midwater and at the surface, that moves in foraging schools up to 

thousands of individuals usually segregated by size and/or sex 

(www.fishbase.org). 

Its diet is composed of bony fishes, cephalopods and crustaceans. 

Reproduction: 

It is an aplacental viviparous species with a very long gestation period from 

18 to 24 months. In the Adriatic sea, pregnant females carrying nearly full-

term embryos have been recorded in summer while fluent males were found 
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all year round. The number of litters varies from 1 to 21. There is no resting 

period between one pregnancy and another, as soon after the parturition a 

female ovulates and is ready to conceive again. 

Size at birth is constant through the Mediterranean basin and ranges between 

245 to 271 mm (Bargione et al., 2019; Capapé & Reynaud, 2011); size at 

sexual maturity (L50) in the Adriatic is 504mm for males and 725mm for 

females; age at maturity is between 9-11 years for males and 10-20 years for 

females; depending on the geographic area they live in, individuals living in 

colder waters take more time to grow and to reach sexual maturity and they 

are more longevous, they can live more than 40 years and the maximum 

recorded age is 75 years. 

IUCN Status 

Global: Vulnerable 

Mediterranean: Endangered 

Its distribution overlaps to that of the areas most subject to fishing effort 

especially in the northern-central Adriatic where the sea bed is entirely 

accessible to towing gears. Moreover its gregarious nature increases its 

captability. Females aggregations are found in deeper waters than male ones 
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except for gravid females aggregations, which are found in more protected 

bays where they give birth. 

 

PRIONACE GLAUCA 

Order: Carchariniformes 

Family: Carcharinidae 

Ecology: 

It is a highly migratory pelagic species found in all marine environments 

between 71°N and 55°S, occurring from the surface to at least 1160m, but 

mostly epipelagic. It is an oceanic species but it can be found close to the 

coast where the continental shelf is narrow and it has a water temperature 

range from 7°C to 21°C. 

It feeds on bony fishes, cephalopods, smaller chondrichthyans, crustaceans 

and cetacean carrion.  

Reproduction: 

It is a placental viviparous species with a gestation period that ranges from 8 

to 12 months depending on the environmental conditions of the habitat it lives 

in, but for the Mediterranean it has been calculated to be around 8 months 
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(Megalofonou et al., 2009). Parturition occurs between spring and summer 

and litters average 30 pups (up to 135 have been recorded). 

Size at birth is calculated to be 30,6cm; size at sexual maturity (L50) in the 

Mediterranean is 202,9cm for males and 214,7 cm for females (Megalofonou 

et al., 2009); age at maturity is 4-6 years for males and 5-7 years for females. 

According to Megalofonou et al., 2009, blue shark in the Mediterranean sea 

reaches sexual maturity in a smaller size but at the same age than the atlantic 

blue shark. 

Mediterranean population is considered independent from the Atlantic 

population but the extent of exchange between population, if there is any, has 

not being understood. 

IUCN Status 

Global: NEAR THREATENED 

Mediterranean: CRITICALLY ENDANGERED 

This species is caught globally as target species or by-catch mainly by 

longlines, purse seine and gillnets both in small and industrial fisheries.  
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In the Mediterranean this species showed a dramatic decline in abundance and 

biomass of 96,5-99,8% from the beginning of 20th century to the beginning 

of the 21st (Ferretti et al., 2008). 

It is one of the most traded species in the fin market contributing to 34,1-

64,2% of the total traded (Fields et al., 2018). 

 

MUSTELUS MUSTELUS  

Order: Carchariniformes 

Family: Triakidae 

Ecology: 

Its areal of distribution comprises the Eastern Atlantic from South Africa to 

the UK and the Mediterranean sea. It is a demersal species that lives on the 

continental shelf till the margin of the continental slope on sandy or muddy 

substrates and in a water temperature range from 10-21°C. It is commonly 

found between 5-50m but it’s been observed at 800m. 

It feeds on mostly on crustaceans that represent the dominant fraction of the 

diet, bivalves, cephalopods and bony fishes. 
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Until recently Mustelus mustelus and Mustelus punctulatus were misidentified 

therefore the exact distribution of each species is not completely known, 

however historical data show a restriction in their distribution in the 

Mediterranean and now they are more commonly found in the Adriatic sea 

and the Strait of Sicily (Riginella et al., 2020).  

Reproduction: 

Smooth-hounds are viviparous placental species and both M.mustelus and 

M.punctulatus have a gestation period of 11 months with parturition occurring 

in April-May. All Mustelus species have a short resting period between 

pregnancies, around 4-6 weeks for specimen studied in the Gulf of Gabès, and 

large oocytes in post-partum females indicates that vitellogenesis proceeds 

also during pregnancy (Saïdi et al., 2008). Fecundity is related to female size 

in both species and is higher in M.punctulatus (mean fecundity = 24) rather 

than M.mustelus (mean fecundity = 11). 

In the north Adriatic Sea, size at birth is 37cm for M.mustelus and 25cm for 

M.punctulatus; L50 is 108,1cm and 91,3cm for males and 121,2 cm and 109,9 

cm for M.mustelus and M.punctulatus respectively, which are higher than the 

one found in the Gulf of Gabès and in the Gulf of Iskenderun showing a 

latitudinal gradient (Riginella et al., 2020); data on age at maturity in the 
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Mediterranean and longevity are available only for M.mustelus and are 8 and 

25 years for females and 7 and 20 years for males (Ozcan & Başusta, 2018). 

IUCN Status 

 M.mustelus M.punctulatus 

Global ENDANGERED VULNERABLE 

Mediterranean VULNERABLE VULNERABLE 

 

Smooth-hounds in the Mediterranean are captured with demersal trawls, 

trammel nets, gillnets and longlines and landings dropped significantly after 

1994 but species-specific data are not available since all smooth-hounds are 

considered the same species after landing (www.redlist.org). However, given 

the life history traits of these species, M.mustelus is more vulnerable to 

fishing than M.punctulatus. 

 

 

 

 

 

http://www.redlist.org/
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SCYLIORHINUS CANICULA 

Order: Carchariniformes 

Family: Scyliorhinidae 

Ecology: 

Small species of shark distributed in the eastern Atlantic from Senegal to 

Norway, in the Mediterranean, and the Black Sea. It is a demersal species 

inhabiting the continental shelf and the uppermost slope from 10-800m depth. 

It is found on a variety of substrates, from muddy to sandy to gravelly and 

coralline bottoms.  

It feeds on benthic invertebrates such as bivalves, crustaceans, small 

cephalopods, polychaetes e small bony fishes. 

Since it doesn’t have pelagic stages and it has a high site fidelity, deep marine 

areas act as a geographical barrier to its dispersal, in fact, in the 

Mediterranean, the small-spotted catshark has a strong genetic differentiation 

(Vasiliki Kousteni & Megalofonou, 2019). 

Reproduction: 

S.canicula is an oviparous species that produces one egg per oviduct and lays 

them simultaneously. The egg cases have tendrils used to secure their 
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attachment on macroalgae, seagrass, or another solid substrate. Eggs hatch 

after 5-11 months depending on water temperature (Koehler et al., 2018).  

The egg-laying period is carried out through the whole year with resting 

periods of few weeks or none, depending on the geographical area and 

females can store sperm for a long time in the oviductal gland (Christian 

Capapé et al., 2008; Finotto et al., 2015). The lack of a seasonal pattern of 

GSI in males suggests that they can mate throughout the year.  

 

The size of egg cases depends on the geographical area and the size of the 

female and ranges from 4,9-7,0cm in length and 1,5-3,0cm in width; L50 for 

the Adriatic is estimated to be around 360cm and the maximum length is 

estimated to be around 490cm, both measurements are higher than the 

corresponding measures for small-spotted catsharks in the Strait of Sicily; 

females can lay from 40 to 240 eggs each year.  

 

Females are slightly smaller than males and this size dimorphism is different 

from the majority of elasmobranch species: while in placental and aplacental 

viviparous species and oviparous species that lay eggs in a short time a 

greater size of the female corresponds to a greater fecundity, in an oviparous 
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species like S.canicula that lays eggs throughout the year this selective 

pressure is not applied since fecundity is not related to female size (Christian 

Capapé et al., 2008). 

IUCN Status  

Global: LEAST CONCERN 

Mediterranean: LEAST CONCERN 

It is caught as bycatch from trawlers, longlines and gillnets but despite 

ongoing fishing pressures it is considered one of the most abundant 

elasmobranchs in the Mediterranean Sea. 
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1.6 Melanomacrophages 

 

Biomarkers are any kind of measurable/evaluable biological indicator on any 

biological state and are divided into two categories: “exposure biomarkers” 

which are measurable quantitative alterations at a molecular, biochemical or 

cellular level, that provide precise indications on the class of contaminants 

involved; and “effect biomarker” that reveal the presence of an alteration but 

don’t provide any indication on the trigger. Some biomarkers have a 

prognostic value while others have a diagnostic significance and they are a 

measure of some effect that was, or still is, present.  

Melanomacrophages (MMs) are considered an effect biomarker with a 

diagnostic value. These cells are present in most fish, amphibians, and some 

reptiles and they appear darkly pigmented due to the high content of melanin, 

lipofuscin and/or haemosiderin. They appear after the first feeding episode 

and are found in the liver, spleen, and head kidney (Agius, 1981). 

Their primary activity is phagocytosis of endogenous (cells) or exogenous 

material (heavy metals, bacteria, pollutants) difficult to process and/or toxic, 

however, they also participate in immune defenses: MMs aggregate in centers 

(MMCs) and these are the place where the antigen, uptaken by MMs, can 

react with lymphocytes in which signals to initiate specific immunity are 

generated. 
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MMCs increase in size and quantity in fish in relation to a variety of 

physiological and environmental stressors and for this reason (high sensitivity 

and low specificity) they are used as a reliable biomarker for the state of fish 

health and for the quality of the aquatic environment (Steinel & Bolnick, 

2017; Stosik et al., 2019). 

In Agnatha and Chondrichthyes, MMs tend to be solitary or present in small 

aggregations of less than 30 cells (Wolke, 1992).  

MMs in sharks have been investigated by only very few studies and, before 

using them as a first-line indicator, baseline levels have to be assessed.  

Given their long life expectancy and life histories that predispose them to the 

accumulation of environmental toxins, sharks are believed to be good 

candidates as bioindicators of the health of the environment they live in 

(Borucinska et al., 2009; Gajić et al., 2020). 
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1.7 Lipid metabolism 

 

Lipids are one of the four main classes of biological macromolecules. They 

are insoluble in water but soluble in organic solvents such as ether, alcohol, 

acetone and chloroform.  

This class comprises an heterogeneous group of molecules, some are esters 

and have fatty acids as carboxylic acids, and some are hydrocarbons. 

The base units of lipid esters are aliphatic chains of different lengths and 

degrees of saturation with a terminal carboxylic group known as fatty acids 

and these molecules have 4 main functions: they are stored as triglycerides in 

adipocytes to be used as energy reserves; they are the main components of 

phospholipids and glycolipids which are the lipids that compose biological 

membranes; they bind to membrane proteins to direct them in the right 

location; they are used as hormones and second intracellular messengers. 

Sharks do not have a swim bladder and they use the liver as their hydrostatic 

organ together with all its other functions and it is also the principal site of 

lipid storage, therefore their hepatosomatic index (HSI) is higher compared to 

teleostean fish. 

Shark liver’s oil (SLO) is composed of triglycerides, which represent the main 

fraction, alkylglycerols and hydrocarbons, with squalene being the most 

represented (Davidson & Cliff, 2002; García et al., 2006; Jayasinghe et al., 
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2003; Navarro-Garcia et al., 2000; Sargent et al., 1973). Triglycerides are 

used as a fuel to supply the energy needed for metabolism while the others are 

mostly used for buoyancy since they have a lower density. 

The lipid content of livers and the quality of fatty acids depends on the 

season, diet, sex, and habitat conditions: deep-sea species have more 

monounsaturated fatty acids, especially oleic acid (C18:1 n-9), as an 

adaptation to maintain a correct membrane fluidity in an environment with 

high pressure and low temperature (Remme et al., 2006); the salmon shark 

Lamna ditropis have a lipid content 20% higher in winter because in this 

season they feed on fish with high lipid content such as salmon, albacore tuna 

and other small elasmobranchs (Jayasinghe et al., 2003). 

Studies on shark liver’s oil (SLO) have been conducted mainly on deep-sea 

species and nowadays the focus is on how it may be used in pharmaceutical, 

medical and nutritional fields (García et al., 2006; Laurino & Palmieri, 2017) 

since it has antioxidant, anti-inflammatory, antibacterial, antifungal, antitumor 

properties given by its components. 
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1.8 Contaminants 

 

Persistent organic pollutants (POPs), heavy metals, crude oil and marine 

debris, such as litter and microplastics (MPs), represent the most common 

marine pollutants globally and can reach the marine environment both from 

direct discharge and atmospheric transport. 

Many pollutants bioaccumulate and biomagnify and apex predator tend to 

have high concentration of pollutants compared to environmental levels. 

Despite this, less attention has been paid to pollutants in elasmobranchs 

compared to other vertebrate groups both for the difficulties related to 

sampling and because fundings may support projects on species that have a 

more positive public perception. 

Most of the studies on pollutants in elasmobranchs are focused on trace 

elements such as mercury (Hg), cadmium (Cd) and POPs such as PCBs and 

DDTs and have found that Hg is accumulates more in the muscle tissue while 

Cd, PCBs and DDTs accumulates in the liver (Tiktak et al., 2020). 

 

The nature of the molecules determines where they accumulate: POPs are 

lipophilic molecules and therefore they are found in tissues with high lipid 

content such as the liver in sharks. POPs (PCBs and DDTs) are found also in 

ova and eggs: during egg-yolk formation females transfer hepatic lipids to 
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maturing oocytes via a lipoglycophosphoprotein called vitellogenin, in a 

process known as vitellogenesis and contaminants are expected to passively 

follow hepatic lipids as they are mobilized. The positive relationship found 

between ova weight and contaminant load supports this statement (Lyons & 

Lowe, 2013) and the process of transfer from the mother to the embryo is 

called maternal offloading. The degree of chlorination of these molecules 

influences their lipophilicity and thus the ability to be transfered: less 

chlorinated PCB congeners are transfered more easily and embryos have 

higher proportions of DDTs metabolites with 4 chlorines and tri, tetra and 

penta PCBs congeners. This pattern is observed in marine mammals like the 

bottlenose dolphin (Tursiops truncatus) and ringed seals (Phoca hispida). 

These molecules have a toxic effect because they can interfere with the 

metabolism of the animals: they can induce systems like the cyt-P450 which 

is involved in the synthesis of steroids and fatty acids and act as a competitive 

inhibitor; they can activate genes involved in other processes like cell 

proliferation and apoptosis; they can stimulate ROS formation. Furthermore, 

since they can be transfered to the embryo and can mimic the structure of 

steroid hormones, they can interfere with fetal development. 
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Mercury enters the marine environment in inorganic form and is transformed 

in its organic form, metilmercury, by sulphate-reducing bacteria in anoxic 

marine sediments and can enter the trophic net. It is bioaccumulated in the 

muscle tissue and it is the only metal that can be biomagnified: the highest the 

trophic level and the dimensions of the animal the higher is the level of 

mercury found in the muscle tissue. 

Methylmercury toxicity in humans is related to the nervous system both in 

adults and in embryos since it can be offloaded by the mother. Methylmercury 

can be offloaded to elasmobranch embryos as well but the effects on their 

physiology is not known (北村 et al., 1997). Furthermore, it has been 

observed that tolerance to pollutants is different among elasmobranch species 

but the effects have been more focused on risks related to humans who 

consume shark derived products rather than the animals themselves (Tiktak et 

al., 2020). 

 

Microplastics (MPs) are defined as fragments of less than 5mm in dimension 

of various shape and nature. The main components of MPs are heavily 

produced low density plastics such as polypropylene, polystyrene and 

polyethylene.  
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MPs are either discharged as such since are used as pellets in the plastic 

industry or as abrasives, or can derive from bigger items that undergo a 

process of degradation and breakdown. 

Due to their low weight, MPs can be transported by currents for long 

distances and are found worldwide in the marine environment and are 

considered carriers of POPs due to the high affinity of hydrophobic organic 

chemicals for MPs. 

MPs constitute a great environmental concern and have negative effects on 

marine fauna because they can transport pollutants; additives such as phtalates 

can leach from the plastic; and the particles can cause physical harm to the 

animals (Cristina et al., 2020). 

MPs in elasmobranchs have not been widely studied and the few articles on 

this topic do not take in consideration MPs effects on the liver of these 

animals. 

 

In conclusion, elasmobranch liver are largely composed of neutral lipids with 

a storage function such as triacylglycerols, which differ from the more polar 

lipids found in other tissues such as the nervous and muscular ones. Thus, 

lipid content and composition probably play a role in how contaminants 

partition themselves among tissues.  
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Elasmobranchs are understudied from a toxicological point of view and this 

study tries to shed new light on these topics. 
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Chapter 2 

 

AIM OF THE PROJECT 

 

The aim of this project is to identify new biomarker for the evaluation of the 

health status of sharks caught in the Adriatic Sea and their susceptibility to 

environmental changes. 

To reach this objective, melanomacrophages have been used as stress 

biomarkers on these organisms, since they are already widely used in teleosts, 

amphibians and reptiles. 

In this study, hepatic melanomacrophages have been evaluated in four species 

of sharks caught in the Adriatic Sea, both from a morphological and 

quantitative point of view, evaluating differences among species, sexes and, 

where possible, between these and the reproductive period. In conclusion, it 

has been assessed if there was any significant correlation between 

melanomacrophages and age of smooth-hound males. 
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Chapter 3 

 

MATERIAL AND METHODS 

 

2.1 Sampling 

 

The animals were collected by fishing vessels in the Adriatic Sea (FAO 

Geographical Area 37, Subarea 37.2, Division 37.2.1) from January 2021 to 

May 2021. Total length was measured from the tip of the snout to the upper 

lobe of the caudal fin and total body weight was measured to the nearest 

gram. At autopsy, liver weight and gonadal weight were measured and two 

sets of random samples of liver and gonad were collected: one set was fixed 

in Formol for histology and the other stored at -80°C for cryostat and FT-IR 

analysis. 

 

2.2 Indices 

 

Gonadosomatic index 

The gonadosomatic index [%] was determined using the formula 

GSI = GW / WT · 100 
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where GW is the gonad weight (g), and WT the total weight of fish (g) 

(Bagenal, 1978). 

 

Hepatosomatic index 

The hepatosomatic index [%] was determined using the formula 

HSI = HW / WT · 100 

where HW is the hepatic weight (g), and WT the total weight of fish (g)         

(Capapé & Reynaud, 2011). 

 

Condition factor 

Condition factor was determined using the formula  

K = (WT / LT) · 10-3 

Where WT is the total weight of fish (g) and LT the total length of fish (m) 

(Blackwell et al., 2000). 

 

 

2.3 Histology 

 

• Paraffin inclusion 

Samples fixed in Formol underwent the embedding process: the first 

step consists of placing samples into biocassettes and removing fixative 
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and water through a series of ascending graded ethanol baths. After 

dehydration, the protocol used required a clearing process through 

xylene baths, to remove the dehydrating medium and to prepare the 

samples for the final embedding process which required samples to be 

placed in paraffin wax. 

 

 

• Microtome 

Samples embedded in paraffin blocks were cut into sections using the 

microtome, with a thickness of 5μm. Sections were put in a bath of 

lukewarm deionized water before being placed on a glass slide. For 

each slide, a total of 3 sections per sample were placed. Glass slides 

were left drying overnight at room temperature for the sections to 

adhere completely to the surface of the slide before proceeding with the 

staining. 

 

 

• Staining process 

Sections were stained with Hematoxylin & Eosin. At first, this protocol 

requires the samples to be deparaffinized through a consequential bath 
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of xylene (Xylene 1 and Xylene 2) before proceeding with a series of 

decreasing graded ethanol baths (100%, 95%, 80%, 70%). After that, 

the slides were soaked first in Hematoxylin, rinsed in a bath with 

running tap water to remove the excess dye, then in Eosin and rinsed 

again. The stained slides were then placed in a series of ascending 

graded ethanol baths (70%, 80%, 95%, 100%) and the last bath in 

xylene to facilitate the mounting of a coverslip on the slide under the 

chemical hood.  

After some trial, a soaking time of 75 seconds in Hematoxylin and 30 

seconds in Eosin were chosen, to have clearer staining on sections of 

both liver and gonads. 

 

 

• Optical microscope 

Stained sections were examined under Zeiss microscope and 2 random 

high-power fields (HPF, 40x) per liver section were selected for a total 

of 6 HPF in total per sample.  
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• ImageJ 

Obtained HPFs were analyzed with imaging software ImageJ and mean 

number of HPF, mean surface area of HPF, mean percentage area of 

HPF covered by MMs and MMCs, and mean percentage area covered 

by lipids were calculated. 

 

The criteria used for counting MMs and MMs were: 

 

1) The cytotype has to be evident: interspersed pigmented granules 

were not considered in the count. 

2) If the pigmented cell had a circular shape and a homogenous 

coloration was considered as MM, on the contrary, it was 

considered as MMC. 

3) Clusters of pigmented granules delimited by a membrane and 

through which the color of the hepatocyte cytoplasm was visible 

were not included in the count. 

4) MMs/MMCs cut by the frame of the image were not included in 

the count. 

 



46 
 

The protocol for calculating the surface area of MMs and MMCs and the 

percentage area covered by them was: 

 

Open image in ImageJ > Select “Straight line” and draw a line of the same 

length of the scale bar > Go to “Analyze” > “Set Scale” > Type “20” in 

“Known distance” and “um” in “Unit of length” > Select “Global” and press 

“OK” 

 

Go to “Analyze” > “Set Measurements” > Select “Area” and “Area fraction” 

and press “OK” 

 

Select “Freehand selections” > Outline the MM or the MMC > Go to 

“Analyze” > “Measure” 

 

For lipid quantification the protocol was as follows: 

 

Open image in ImageJ > Go to “Image” > “Type” > “8-bit” 

 

Go to “Analyze” > “Set Measurements” > Select “Area fraction” only and 

press “OK” 
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Go to “Image” > “Adjust” > “Threshold” > Adjust the threshold until all the 

lipid globules (white areas) are highlighted and nothing else > Go to 

“Analyze” > “Measure” 

 

2.4 Statistical analysis 

 

Statistical analysis was performed using GraphPad software for ANOVA and 

t-test analysis and JASP software was used for Pearson’s correlation analysis. 

One-way ANOVA followed by Tukey’s post hoc test was performed to 

evidence differences of all melanomacrophages and lipids parameters among 

species and sexes. Two tailed t-test was performed to evidence differences 

between males and females of M.mustelus both in pre and post-mating season. 

Pearson’s correlation was performed among all biometric, 

melanomacrophages and lipids parameters of males of M.mustelus. 

 

2.5 FT-IR measurements and data analysis 

 

A Bruker VERTEX 70 interferometer coupled with a Hyperion 3000 Vis-IR 

microscope was used. The spectrometer was equipped with a liquid nitrogen 

cooled bidimensional Focal Plane Array (FPA) detector that allows to 
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perform the imaging analysis of non-homogeneous biological samples by 

simultaneously acquiring 4096 spectra on an area of 164x164 μm2. The 

visible image of each liver section was obtained with a 15X 

condenser/objective. On these selected areas, IR maps were collected in 

transmission mode in the 4000-900 cm-1 MIR range with a spatial resolution 

of ~2.56 μm. Each spectrum was the result of 256 scans with a spectral 

resolution of 4 cm-1. Background spectra were acquired on clean regions of 

CaF2 optical windows.  

Raw IR maps were corrected by applying the Atmospheric Compensation 

routine, to remove the contribution of atmospheric carbon dioxide and water 

vapour, and then vector normalized in the 4000-900 cm-1 spectral range, to 

avoid artefacts due to differences in thickness (OPUS 7.1 software, Bruker 

Optics, Ettlingen, Germany).  

These preprocessed IR maps were integrated under the following spectral 

regions, to obtain false colour images representing the topographical 

distribution and relative amount of the most relevant biochemical features: 

2995–2825 cm-1 (containing the vibrational modes of lipids, named LIPIDS); 

1718–1481 cm-1 (containing the vibrational modes of proteins, named 

PROTEINS); 1274–1181 cm-1 (containing the vibrational modes of 

phosphates groups inside nucleic acids, named PHI DNA), and 1130–1013 
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cm-1 (containing above all the vibrational modes of pentos, named PHII 

DNA). An arbitrary colour scale was used, white colour indicating areas with 

the highest absorbance values and blue colour areas with the lowest ones. 
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Chapter 4 

 

RESULTS  

 

The presence of melanomacrophages in liver sections was determined in the 

samples belonging to four species of shark: the blue shark, P.glauca (PG); the 

small-spotted catshark, S.canicula (SC); the spiny dogfish, S.acanthias (SA); 

and the common smooth-hound M.mustelus (MM). By comparing 

morphology and color of melanomacrophages, differences between the 

species emerged (Fig.1). Very few melanomacrophages were found in the 

blue shark and they appear regular in shape and homogenous in color 

(Fig.1a). In the small-spotted catshark, melanomacrophages were found in 

high number and big in size, tending towards a rounded shape, both with a 

grainy texture and homogenous in color (Fig.1b). In the spiny dogfish these 

cells appear irregular in shape and color (Fig. 1c). In smooth-hounds they tend 

to assume a regular shape and a homogenous coloration. Some centers are 

surrounded by a capsule, which represents a superior level of organization 

(Fig.1d). 

From liver sections it was possible to qualitatively analyze the lipid globules 

present in the tissue. Differences between species regarding lipid globules 
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were found (Fig.1). In the blue shark’s section all lipid globules have a 

rounded shape and two types of lipid globules, based on dimensions, were 

found: one with a medium diameter of 64,230 μm and one with much smaller 

globules than the former, with a medium diameter of 17,538 μm. The big lipid 

globules do not tend to merge and they remain well separated from each other 

(Fig.1a) In the small-spotted catshark, lipid globules are evident but small 

(Fig.1b). In the spiny dogfish, all lipid globules have a rounded shape and 

have a similar size of around 28.026 μm in diameter. Some globules tend to 

merge while others stay separated (Fig.1c). In the smooth-hound the 

dimensions of the globules are variable and the shape is not properly rounded 

due to the merging of more globules (Fig. 1d). 

Macromolecular characterizations of the liver sections are shown in       

Figure 2-5. The white areas in the microphotographs correspond to the highest 

absorption values of lipids while the areas with the higher absorption values 

of proteins corresponds to the parenchymatous hepatic tissue.  
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Figure 1 – Liver’s section of (a) blue shark, P.glauca; (b) small-spotted 

catshark, S.canicula; (c) spiny dogfish, S.acanthias; (d) common smooth-

hound; M.mustelus. Arrows indicate lipid globules, arrowheads indicate 

melanomacrophages. Hematoxilin and eosin, 40x. 
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Figure 2 -  FT-IR microspectroscopy analysis of a liver section of P.glauca. 

Microphotograph (164x164 μm2). IR maps representing the topographical 

distribution of: Proteins, Lipids, Fatty Acids and Lipid Peroxidation relative 

to unsaturated fatty acids. Due to different molar extinction coefficients of the 

analyzed peaks, different scales were used for each IR map (blue colour 

indicating the areas with the lowest absorption values, while white colour the 

highest ones). 
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Figure 3 -  FT-IR microspectroscopy analysis of a liver section of S.canicula. 

Microphotograph (164x164 μm2). IR maps representing the topographical 

distribution of: Proteins, Lipids, Fatty Acids and Lipid Peroxidation relative 

to unsaturated fatty acids. Due to different molar extinction coefficients of the 

analyzed peaks, different scales were used for each IR map (blue colour 

indicating the areas with the lowest absorption values, while white colour the 

highest ones). 
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Figure 4 -  FT-IR microspectroscopy analysis of a liver section of 

S.acanthias. Microphotograph (164x164 μm2). IR maps representing the 

topographical distribution of: Proteins, Lipids, Fatty Acids and Lipid 

Peroxidation relative to unsaturated fatty acids. Due to different molar 

extinction coefficients of the analyzed peaks, different scales were used for 

each IR map (blue colour indicating the areas with the lowest absorption 

values, while white colour the highest ones). 
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Figure 5 -  FT-IR microspectroscopy analysis of a liver section of 

S.acanthias. Microphotograph (164x164 μm2). IR maps representing the 

topographical distribution of: Proteins, Lipids, Fatty Acids and Lipid 

Peroxidation relative to unsaturated fatty acids. Due to different molar 

extinction coefficients of the analyzed peaks, different scales were used for 

each IR map (blue colour indicating the areas with the lowest absorption 

values, while white colour the highest ones). 
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Figure 6 shows the differences between the mean number and mean area of 

melanomacrophages (both MMs and MMCs) among species. Figure 6a shows 

a significant difference of mean number of MMs between SC and SA            

(p < 0.05). Regarding the mean number of MMCs, a statistically significant  

(p < 0.05) difference was evidenced between MM and SC (Fig. 6b). No 

differences were evidenced among species about mean area of MMs (Fig. 6c). 

Concerning the mean area of MMCs, statistically significant differences were 

found between MM and SC (p < 0.0001) and between SC and SA (p < 0.01) 

(Fig. 6d). No differences were found about the mean percentage of HPF 

occupied by MMs among species (Fig. 6e). Regarding the mean percentage of 

HPF occupied by MMCs, statistically significant differences were evidenced 

between MM and SC (p < 0.0001) and between SC and SA (p < 0.01)       

(Fig. 6f). 
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Fig.6 – Histogram shows mean number (a, b), mean area (c, d) and mean 

percentage of HPF occupied by MMs and MMCs (e, f) (mean ± SEM).          

MM (M.mustelus); SC (S.canicula); SA (S.acanthias); PG (P.glauca)                  

(p-value < 0.05). 

 

 

Regarding hepatic lipid content, the lowest amount was found in SC while the 

highest amount in SA. MM and PG showed intermediate values (Fig.7). 
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Fig.7 - Histogram shows levels of hepatic lipid content in HPF (mean ± 

SEM). MM (M.mustelus); SC (S.canicula); SA (S.acanthias); PG (P.glauca). 

Different letter indicates statistically significant differences. 

 

Where there was the availability of males and females, a comparison was 

made between melanomacrophages and lipids quantification among sexes. In 

SC, females showed the lowest mean number of MMs compared to males     

(p < 0.05) (Fig. 8a). A similar trend was observed for mean number of 

MMCs, but no statistically significant differences were evidenced (Fig. 8b). 

Concerning mean area of MMs no statistically significant differences were 



61 
 

found between sexes (Fig. 8c). Conversely, statistically significant differences 

were evidenced focusing on mean area of MMCs, where males showed higher 

values (p < 0.001). No differences were evidenced between sexes about mean 

percentage of HPF occupied by MMs (Fig. 8e). Regarding mean percentage 

of HPF occupied by MMCs, higher values were found in males (p < 0.001) 

(Fig. 8f). 
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Fig. 8 - Histogram shows mean number (a, b), mean area (c, d) and mean 

percentage of HPF occupied by MMs and MMCs (e, f) in males and females 

of S.canicula (mean ± SEM) (p-value < 0.001). 

 

Concerning hepatic lipid content, females showed a significantly higher 

amount in females rather than males (p < 0.001) (Fig.9). 
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Fig. 9 - Histogram shows levels of hepatic lipid content in HPF in males and 

females of S.canicula (mean ± SEM) (p-value < 0.001). 

 

In MM, individuals of both sexes before and after the mating season were 

available. Differences were evidenced about mean number of MMs between 

males and females pre-mating (p < 0.05), while, in the post-mating season, an 

increasing trend in the former and a decreasing trend in the latter with no 

statistically significant relevance were found (Fig. 10a). Concerning the mean 

number of MMCs, differences were found between males and females pre-

mating (p < 0.05) and between females in the pre-mating season and females 

in the post-mating season (p < 0.05). Between males pre and post-mating, an 
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increasing trend is visible but with no statistical significance (Fig. 10b). No 

differences were evidenced about mean area of MMs, mean area of MMCs, 

mean percentage of HPF occupied by MMs and mean percentage of HPF 

occupied by MMCs in both sexes and in both seasons (Fig. 10c-f).  
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Fig.10 - Histogram shows mean number (a, b), mean area (c, d) and mean 

percentage of HPF occupied by MMs and MMCs (e, f) in males and females 

of M.mustelus in pre and post-mating season (mean ± SEM) (p-value < 0.05).  

 

Regarding hepatic lipid content, statistically significant differences were 

evidenced between males pre and post-mating (p < 0.05), between females 

pre and post-mating (p < 0.0001), between males and females pre-mating     

(p < 0.0001) and between males and females post-mating (p < 0.0001)      

(Fig. 11). 



66 
 

 

Fig.11 - Histogram shows levels of hepatic lipid content in HPF in males and 

females of M.mustelus in pre and post-mating season (mean ± SEM). 

Different letter indicates statistically significant differences (p-value < 

0.0001). 

 

In males of MM correlations between all biometric data and data on 

melanomacrophages and lipids were found (Table 1). 

. 
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Chapter 5 

DISCUSSIONS 

 

Sharks are considered endangered by overfishing because of their life history 

traits, but is this the only threat these animals are facing or environmental 

changes are also playing a role in their overall health status?  

In order to determine the environmental stress, biomarkers are needed and 

melanomacrophages have been used in a wide range of species of fish (Kalita 

et al., 2019; Nowak et al., 2021; Qualhato et al., 2018; Viana et al., 2021) 

while in sharks these cells have been poorly studied. To be able to use these 

cells as a valuable biomarker the first step is understanding how they work 

and if there are any variations not related to the environmental stress, such as 

variations among sexes, due to the reproductive period and to age. In this 

study melanomacrophages were observed for the first time in the liver of 

M.mustelus and S.acanthias while in P.glauca they were observed by 

Borucinska et al., 2009 in the northwestern Atlantic and in S.canicula by 

Gajić et al., 2020 in the eastern Adriatic.  

The results show that S.canicula have the highest number of both MMs and 

MMCs, an higher mean area of MMCs as well as a lower hepatic lipid content 
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compared to the other considered species. Data on morphometric values of 

melanomacrophages suggest that this species may be more subjected to acute 

and chronic stress compared to the other species considered (Agius & 

Roberts, 1981; 2003; Kalita et al., 2019; Qualhato et al., 2018; Viana et al., 

2021; Wolke, 1992). This may be explained by the fact that this species is a 

demersal species closely related to the bottom, where lipophilic pollutants 

tend to accumulate. Due to the contribution of Po River, the Adriatic Sea is 

characterized by fine grain sediments, from sand to silt to clay moving 

outward from the coast (Palumbo & Selvaggi, 2003; SNPA, 2018) and the 

lowest the grain size of the sediment, the higher is the adsorption capacity of 

it (Karickhoff et al., 1979). Therefore bottom-dwelling species are more 

exposed to contaminants that accumulate in the sediments. Furthermore, as 

observed in other studies, sharks tend to accumulate more lipophilic 

contaminants in the liver due to a higher content of lipids and a lower activity 

of cytochrome P450 enzymes compared to teleosts (Cresson et al., 2016; 

Gorbi et al., 2004; Jeffree et al., 2006, 2010). Moreover, small-spotted 

catshark shows a strong genetic differentiation in the Mediterranean basin due 

to a high degree of site fidelity and a low dispersal capacity (Rodríguez-

Cabello et al., 2004; V. Kousteni et al., 2015) therefore it might be more 

susceptible to long-term pollution. According to Combi et al., 2020 , PAH, 
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PCBs and DDTs in the sediments of the western Adriatic Sea pose limited 

risk of toxicity in marine organisms, except for the PAH dibenzo[a,h] 

anthracene. However, their study did  not take in consideration other 

pollutants such as microplastics or heavy metals.  

From the results of this study, hepatic lipid content is around 3.5 times higher 

in females rather than males of S.canicula. Annual variation in HSI in the 

small-spotted catshark occur both in males and in females but are wider in the 

latter because continuous vitellogenesis occurs (Craik, 1978). The variation of 

this parameter in both sexes is related to deposition of lipid reserves in the 

liver based on season: in the Adriatic and Aegean Sea it has been observed 

that feeding intensity is lower in winter due to a decrease in food availability, 

metabolic rhythm and thus food demands (Kousteni et al., 2017;  Jardas et al. 

2004; Šantić et al. 2012). An aspect that comes out from the results in this 

study is the fact that dimensions of MMCs in S.canicula are inversely 

proportional to hepatic lipid content suggesting that there might be a 

correlation between these two parameters in this species. 

In M.mustelus, MMCs are present in lower numbers in the post-mating season 

in both sexes and they are always more abundant than MMs in males; in 

females, MMs are more abundant than MMCs in the pre-mating season while 

in the post-mating season the latter is present in higher number than the 
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former. For what it concerns lipids, females have more hepatic lipid content 

than males in the pre-mating season while in the post-mating season males 

have more lipid in their liver rather than females. 

For what concerns M.mustelus, females sampled in the pre-mating period 

have a mean number of both MMs and MMCs higher than males, suggesting 

that they may be more susceptible to both acute and long-term stress. 

However, females in post-mating period show a significant decrease in the 

mean number of MMCs and hepatic lipid content compared with female in 

pre-mating period. These results may suggest that females during their 

preparation to the mating season, invest their energy mainly towards 

reproductive functions, such as vitellogenesis, instead than towards the 

maintenance of the homeostasis. Furthermore, following this hypothesis, they 

would need more energy to accomplish vitellogenesis, resulting in a higher 

food intake and therefore a higher level of liver metabolism. M.mustelus is a 

demersal species that feeds mainly on benthic invertebrates and bony fishes 

therefore it might be exposed to lipophilic contaminants that accumulate in 

liver due to its high lipid content, similarly to S.canicula. M.mustelus is a 

viviparous species therefore, in addition to large yolk-filled eggs, viviparous 

elasmobranchs provide additional nutrition to embryos in the form of yolksac- 

placental conveyance (Wourms et al., 1988) and lipophilic pollutants can be 
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transferred to the ova during vitellogenesis, and to the embryo during 

pregnancy  (北村 et al., 1997; Tiktak et al., 2020; Lyons et al., 2021). The low 

hepatic lipid content might mean that vitellogenesis have occurred and that 

the decrease of number of MMCs is related or to a better functioning of the 

immune system after the mating period or to a detoxification process of the 

liver due to the offloading of pollutants to the ova.  

To validate this hypothesis further research is needed and also it can not be 

excluded that the results obtained in this study are biased from sample 

availability.  

Finally, no significant correlation between total length (LT) and mean number 

of MMCs was found in males of M.mustelus. This result could be due to the 

fact that the individuals of all ages are equally impacted by some sort of stress 

or these individuals show a narrow age span for this species. In fact, these 

specimens have a range of LT from 0.6m to 1.1m, corresponding to a range 

from 3 to 8 years (Ozcan & Başusta, 2018). To confirm these outcomes new 

specimens and analysis are needed. 

In conclusion, this study is just a staring point which provides new solid 

insights on identifying new valuable biomarkers to monitor health status of 

sharks and their susceptibility to environmental changes. 
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